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Introduction 
 

Missouri law requires that employers submit their annual Withholding reconciliation using 
the electronic format if the total number of W-2 statements meets or exceeds 250. We 
encourage all employers, regardless of the number of W-2s, to file electronically. 

 
For employers required to file W-2 wage/tax statements electronically, the electronic filing 
deadline is January 31st. If the due date falls on a Saturday, Sunday or legal holiday, the 
statements must be filed by the next business day. Employers not required to file 
electronically must submit their W-2s on or before the last day of February. 

 
The 2020 Missouri Employer Reporting of W-2s Instructions and Specifications Handbook is 
designed to be used as a companion to the Social Security Administration (SSA) Publication 
No. 42-007 EFW2 Tax Year 2020. Since many functions of the Missouri employer-reporting 
program are similar to the SSA program, this handbook highlights the special requirements of 
the Missouri program. 
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Filing Requirements for W-2 Wage Data 

Employers with 250 or more W-2 forms to report must file electronically as described on the 
next page. Filing electronically requires the generation of an EFW2-format text file which is 
described in the Social Security Administration (SSA) Publication No. 42-007 EFW2 Tax Year 
2020, “Specifications for Filing Forms W-2 Electronically (EFW2)”. Additionally, this handbook 
will have the necessary Missouri modifications, as mentioned in the introduction. 

 
Employers failing to file in the method (electronically for those with 250 or more employees) 
or by the due date, taking into account any extension of time granted, unless it is shown that 
such failure is due to reasonable cause, may incur a penalty of two dollars per statement not 
filed, not to exceed one thousand dollars, as authorized by Section 143.731.2 RSMo. 
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Electronic Filing of W-2 Wage Information  
 

Bulk Upload Process 

The Bulk Upload Process allows the user (employer/payroll provider) to upload a text file, 
compiled in the required EFW2 format. The file can contain W2/MO-3 information for multiple 
employers (see Electronic File/Records).  

 
When a file cannot be processed, the user will be notified by email, any reject is a reject of the 
entire file.  The email will contain a subject of “EFW2 Rejected”; the email will include 
recommendations on how to correct the file.  When resubmitting a file after a reject be sure to 
upload the entire file, as if you are submitting for the first time. 
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Electronic Filing Record Requirements 

Below are the Missouri records in the EFW2-format file* for reporting of W-2s and submission 
of the electronic MO-W3. These required records must be 512 bytes and are described in detail 
further in this document. The RA record required by Missouri is identical to the RA record in 
the file required by the SSA Publication No. 42-007 EFW2 file. The RV record is specific to the 
Missouri W-2 file. Your software may compile a single file that serves both federal file 
requirements and Missouri requirements. You may open your file using Notepad to see these 
records once it has been generated. 

 
RA - Submitter Record (Same record layout as SSA Publication No. 42-007 EFW2 Tax Year 

2020) 
RE - Employer Record     (Same record layout as SSA Publication No. 42-007 EFW2 Tax Year 

2020)  
RW - Employee Wage Record (Same record layout as SSA Publication No. 42-007 EFW2 Tax 

Year 2020) 
RS - State Record (Same record layout as SSA Publication No. 42-007 EFW2 Tax Year 

2020) 
RT – Total Record (Same record layout as SSA Publication No. 42-007 EFW2 Tax Year 

2020) 
RV – State Total Record (Modified record layout description)  

RF – Final Record (Same record layout as SSA Publication No. 42-007 EFW2 Tax Year 
2020) 

Note: 

• Multiple companies can be submitted in one file. If submitting for multiple companies, 
repeat each set of record types RE, RW, RS, RT, and RV in this sequence for each company 
you are submitting, with only a single RA record at the beginning of the file and a single 
RF record at the end of the file. 

• Data must be uppercase letters in ASCII. 
• File should include record delimiters (CR- Carriage Return followed by LF – Line Feed). 

Each record delimiter must consist of a carriage-return/linefeed (CR/LF) and placed 
immediately following position 512. Do not place a record delimiter before the first 
record (RA) of the file. This is the same as stated in SSA Publication No. 42-007 EFW2 
Tax Year 2020, section 7.3 Data Requirements. 

• Each record type (RA, RE, RW, RS, RT, RV, RF) starts on a new row. 
• Electronic files submitted by bulk upload cannot be compressed or password protected.  

The file you upload is placed on an encrypted server. 
 

*The electronic file that you create may be opened and viewed using Notepad. It is helpful to 
click on “View” tab and check the “Status Bar” so that the column/line numbers appear at the 
bottom, right corner of the screen, below the left-right scroll bar. Also, click on the “Format” tab 
to make sure Word Wrap is NOT checked. 
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Reminders for Tax Year 2020 
1. The filing deadline of W-2 wage/tax statements for taxpayers required to file 

electronically is February 1, 2021. Missouri will begin accepting files December 7, 2020. 

2. The “RV” record is the electronic version of the paper form, MO-W3, Annual Employer 
Reconciliation Return. The RV record contains all fields from the MO-W3 form and is a 
required record for a successful file validation. 

3. If you outsource your payroll, please provide the transmitter/submitter with the correct 
Federal Employer Identification Number (FEIN) and the correct Missouri Identification 
Number. The information is located in the Employer Withholding Tax Returns Coupon Book.  
Please contact Taxpayer Services at 573-751-7200 if you need a confirmation of your MoID. 

4. Do not submit paper documents after filing electronically 
This may result in errors on your account. 
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Most Common Errors to Avoid 
 
 

• Failure to include the RA record will result in the file not being processed. 
 

• Failure to include the RV record containing the MO-W3 information. 
 

• Failure to include the RF record at the end of the file. 
 

• Invalid Missouri Identification Number used. 
 

• Using the FEIN instead of the Missouri identification number. 
 

• Uploading PDF, MsWord or Excel files. These are not acceptable formats. This will result in 
a filing reject. 

 
• The file missing record delimiters (CR- Carriage Return followed by LF – Line Feed). Each 

record delimiter must consist of a carriage-return/linefeed (CR/LF) and placed 
immediately following position 512. Do not place a record delimiter before the first record 
(RA) of the file. This is the same as stated in SSA Publication No. 42-007 EFW2 Tax Year 
2020, section 7.3, Data Requirements. 
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Record Format Rules 
 

Global format requirements 
 
All fields in the record layouts are required and must follow the formatting rules as follows: 

 
Alpha fields (Alphabetic characters and blanks only) 

 
• Left justify and fill with blanks. 

 
Numeric fields (Numeric characters only) 

 
• Right justify and fill with zeroes. 

 
• Fill unused fields with zeroes. 

 
Alpha/numeric fields (Alphabetic, numeric, blanks and special characters as allowed) 

 
• Left justify and fill with blanks. 

 
• Fill unused fields with blanks. 

 
Money fields 

 
• Must contain only numbers, no spaces. 

 
• No punctuation. 

• No signed amounts (high order signed or low order signed). 
 

• Include both dollars and cents with the decimal point assumed (example: $59.60 = 
000000005960). 

 
• Do not round to the nearest dollar (example: $5,500.99 = 000000550099). 

 
• Right justify and zero fill to the left. 

 
• Any money field that has no amount to be reported must be filled with zeroes, no spaces. 

 
Note: If SSA Publication No.42-007 EFW2 Tax Year 2020 instructs to use blanks for 
alpha/numeric fields, enter blanks unless Missouri specifies other. 
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“RA” Record 
 
Use record layout defined in SSA Pub #42-007 EFW2 Tax Year 2020 

 
 

“RE” Record 
 

Use record layout defined in SSA Pub #42-007 EFW2 Tax Year 2020 
 
 

“RW” Record 
 

Use record layout defined in SSA Pub #42-007 EFW2 Tax Year 2020 
 
 

“RS” Record – Use State Code 29 for Missouri 
 

Use record layout defined in SSA Pub #42-007 EFW2 Tax Year 2020 
 
 

“RT” Record 
 

Use record layout defined in SSA Pub #42-007 EFW2 Tax Year 2020 
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“RV” Record Modified for Missouri Reporting 
 

RV RECORD 
FIELD POSITION 

FIELD NAME FIELD 
LEGNTH 

FIELD TYPE FIELD DESCRIPTION 

1-2 Record Type 2 Alpha Required. Enter "RV." 
3-6  Tax Year 4 Numeric Required. Enter the tax year for this 

report. 
7-15 Federal Employer 

Identification 
Number 

9 Numeric Required. Enter the EIN under 
which tax payments were 
submitted. Enter only numeric 
values. Omit hyphens. 

16-23 State ID 
Number 

8 Numeric Required. Eight-digit Missouri 
Identification Number (Tax 
Withholding Account Number).  

24-80 Employer Name 57 Alpha Numeric Required. Enter the name 
associated with the State ID 
entered in positions 16-23. Left 
justify and fill with blanks. 

81-86 Employer Number 
of W-2s 

6 Numeric Required. Enter total number W- 2s 
coded for Missouri. 
Right justify and zero fill. 

87-98 Employer Total 
Tax Withheld as 
shown on W-2s 

12 Numeric Required. Enter the total state 
withholding tax for all Missouri 
employee records in the file.  
Right justify and zero fill. 

99-512 Blank 414 Alpha Numeric Fill with blanks. 

 
“RF” Record 
 

Use record layout defined in SSA Pub #42-007 EFW2 Tax Year 2020 
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To View the Electronic File 
 

Open the EFW2 file using Notepad.  Some hints to navigate this file to make corrections: 
 

• Click on the View tab and make sure the Status Bar is checked. This will allow for the Line 
number and Column number (example. Ln 1, Col 1) to appear at bottom right corner of the 
screen, below the scroll bar that goes from left to right. 

 
• Click on the Format tab and make sure Word Wrap is unchecked. 

• Use caution when adding/subtracting fields in each line, that the remainder of the line is 
held in position. 

 
 

QuickBooks Users’ Common Question 
 

Do not upload QuickBooks’ EXCEL or PDF files. These are not acceptable formats. You must 
create a “W2REPORT” text file from QuickBooks and upload the text file to bulk filing website at 
https://dor.mo.gov/business/withhold/EFW2.php. 
 
There is neither a direct link nor an automated link to upload from QuickBooks to the State 
of Missouri. 

 
Please contact QuickBooks support for instructions on how to create the “W2REPORT” text 
file. 
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Frequently Asked Questions 
 

Who must file W-2s? 
 

Any employer with business ties to Missouri (i.e. employees receiving Missouri wages, 
employees living in Missouri). 
Beginning January 1, 2018: 

• Employers with 250 or more employees must electronically file W-2 forms with the 
Department by January 31st. 

• Employers with less than 250 employees must file W-2 forms with the Department by 
the last day of February.  These may be filed electronically, but not required. 

• The 1099 forms must be filed with the Department by the last day of February. These may 
be filed electronically, but not required. 

 
What is the Missouri Identification number? 

 
The Missouri Identification Number (MoID) is an eight-digit number assigned by Missouri 
when you register your business with Missouri. 

 
How can I confirm an employer’s Missouri Identification number? 

 
You can contact our taxpayer assistance phone lines by telephone at 573-751-7200, by e-mail 
at businesstaxregister@dor.mo.gov, or by fax at 573-522-1722. Be prepared to provide the 
following information: Federal Employer Identification Number (FEIN); name of company. 

 
How do I name my electronic file before submitting it to the Department? 

 
Any file name is accepted. 

 
What other methods of filing are accepted? 

 
Employers having less than 250 W-2 wage tax statements to report may send a paper Form 
MO-W3 with paper copies of the W-2 wage tax statements, or compact disc(s), or flash 
drive(s) containing the data to: 

 
Missouri Department of Revenue  
P.O. Box 3330  
Jefferson City, Missouri 65105-3330 

 
Please refer to the Missouri Employer’s Tax guide for more information on these filing 
methods. 

 
Can I file my corrections electronically or on magnetic media? 

 
No, we cannot process W-2Cs or MO-W3 corrections electronically. 

 

mailto:businesstaxregister@dor.mo.gov
https://dor.mo.gov/forms/4282_2020.pdf
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If after you have filed your Form W-2(s) and Form MO W-3, you discover an error in Line 17 
of the original W-2(s), and need to file a Form W-2C(s) you must correct it by remitting an 
amended Form MO-941. This form must be used to increase or decrease any previously 
reported tax amounts. Attach a copy of the Form W-2C(s) to the amended Form MO-941 
and Form W-3. If you have discovered an incorrect figure was indicated on the original 
Form MO W-3; however, no changes need to be made to the amount of withholding: submit 
a new Form MO W-3 with the correct figures and check W-3 Corrected on the top left 
corner. Note: Do not send copies of W-2C(s), if no change in withholding tax liability. 

 
Am I required to submit a test file? 

 
No, test files are not required. Software developers interested in testing formatting changes 
should contact Electronic Services at elecfile@dor.mo.gov or 573-751-8150. 

 
Is there a filing deadline? 

 
The filing deadline for electronic submissions of W-2 wage tax statements for employers with 
250 or more employees is January 31. The filing deadline for employers with less than 250 
employee W-2 wage tax statements is the last day of February. If any due date falls on a Saturday, 
Sunday or legal holiday, the statements must be filed by the next business day.  

 
What is the earliest year I can submit using the EFW2 Upload Application? 

 
The earliest year that can be submitted using the EFW2 Upload Application is tax year 2017. 

 
Where do I send back-year data since I cannot submit it through the bulk upload 
application? 

 
Mail all back-year information to:  
Missouri Department of Revenue  
P.O. Box 3330  
Jefferson City, Missouri 65105-3330 

 
Can I submit for multiple employers? 

 
Yes. Multiple employers can be submitted within one file. Be sure to include one set of record 
types in this sequence (RE, RW, RS, RT, RV) for each employer. 

 
Do you return the data submitted? 

 
No, data submitted becomes the property of the Revenue Administration Division and for 
security reasons it is destroyed after being successfully processed. 

 
What if I am having difficulty creating my W2 file? 

 
If you are having difficulty in creating your W2 file, please call us at 573-751-8150, or email to 
elecfile@dor.mo.gov, or by fax to 573-526-5915.  

mailto:elecfile@dor.mo.gov
mailto:elecfile@dor.mo.gov,
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